
W e showed you in our April issue how to create a Video 
CD (or VCD) that allows you to play movies—housed 
on a CD—in most set-top DVD players. If you don’t 

have a DVD burner, VCDs are a relatively cheap and convenient 
way of sharing your digital movies with those who don’t have 
a computer—and a narcissistic way of fawning over yourself on 
TV. The downer is that you have to deal with a VCD’s VHS-like 
quality. Or do you?

If you’re willing to put a little extra muscle into your efforts, 
you can get near–DVD-quality video on a regular CD-R by 
creating a Super Video CD. It won’t cost you a penny more than 
creating a regular VCD, since most of the required software is 
free and you likely have the rest. Here’s how to make one.

Got a TV 
and a DVD player? 
You can watch your iMovies in 
near-DVD quality from a mere CD-R disc if 
you create an SVCD.

2Export Video and Audio Open the movie in your video 
editor, and export it (or its fi rst chapter) in high-quality DV format at 720 
by 480 pixels. To do this in iMovie, select Export from the File menu. 
In the resulting dialog, choose To QuickTime from the Export pop-up, 

select Full Quality DV from the Formats pop-up, and click Export. Do a second 
export of just the audio track, saving it as a 16-bit, 44.1KHz stereo AIFF fi le. In 
iMovie, select Export from the File menu, select To QuickTime from the Export 
pop-up menu, select 
Expert Settings from 
the Formats pop-up, 
and click Export. In the 
resulting dialog, choose 
Sound To AIFF from the 
Export pop-up, select 
44.1KHz 16-bit Stereo 
from the Use pop-up, 
and click Save.

If you’re using iMovie, 
export just the audio 

tracks by selecting 
Sound To AIFF from  

the Export pop-up in 
Expert Settings.

1Get the Goods Before you can 
Toast, you’ve gotta have the ingredients, 
meaning you need to install the software 
fi rst. First install Apple’s Developer 

Tools. You can download the whopping 300MB 
free package from Apple’s Developer site (or pay 
20 bucks and Apple will hand it to you on a shiny 
4 3/4-inch platter). Then install MediaPipe—
double-click either Local Install if you only want 
the tools available to your account or System 
Install for all-user access. The remaining apps 
don’t require installation.

MediaPipe offers two installers; choose Local for 
sole tool access or System for all-user access.

by Andrew Tokuda

Create a Super 
Video CD

WHAT YOU NEED
• Mac OS 10.2 or later ($129, www.apple.com)
• Roxio Toast 5.1.2 or later ($99.95 boxed or $89.95 

download, www.roxio.com)
• MediaPipe (free, http://mediapipe.sourceforge.net)
• MissingMpegTools (free, http://homepage.mac.com/rnc)
• MissingMenuGen (free, http://homepage.mac.com/rnc)
• Apple Developer Tools (free, http://developer.apple.com

/tools/macosxtools.html)
• VideoLAN Client (free, www.videolan.org)
• Video-editing app (such as 
 Apple’s iMovie or Final Cut Pro)
• CD-R/CD-RW drive
• Mondo disk space

ON THE
DISC

MediaPipe 0.8.9r2, MediaPipe 0.8.9r2, 
MissingMenuGen 1.0, 
MissingMpegTools 
0.9.1, and VideoLAN 
Client 0.5.3
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4Encode Audio to MP2 Next, 
convert your AIFF fi le into an MPEG-1 Layer 
2 (MP2) fi le. Click the Mp3enc tab, click 
Set Path, select your exported AIFF in the 

resulting dialog, and click Choose. In the subsequent 
dialog, select the same output folder you used for 
your video, and click Choose. Leave the default 
settings, but make sure the VCD Compliant box is 
checked. Then click Encode to start the Terminal 
process for the audio section.

Encoding AIFF audio to MP2 is a process similar to 
encoding video—and just as boring to watch.

5Mux the Media You now have an 
MPEG-encoded video (MPV) and audio (MP2) fi le 
that you need to merge. This process is called 
multiplexing, or muxing. Click the Mplex tab, then 

click Set Path. In the resulting dialog, select the MPV fi le and 
click Choose. In the subsequent dialog, select the MP2 fi le and 
click Choose. In the next dialog, click Choose to select your 
current output folder. In the Name Of Output File fi eld, name 
your movie, keeping the .mpg extension; leave the default 
settings. Then click the Mux button to fuse the fi les. If you 
have more videos, encode and mux each of them in sequential 
order. Keep in mind that an SVCD holds about 45 minutes of 
average-quality video (see “Quality Control,” p66). To preview 
your muxed video, play the MPEG fi le in VideoLAN Client.

6Make the Menu If you’ve got multiple videos, a menu 
is key for navigation. Because the user will navigate SVCD 
movie sequences via the numbers on a DVD player’s remote 
control, add a numeric reference to each movie thumbnail 

in your menu. For menu-creation instructions, see “Create a Static 
SVCD Menu,” p67. Your graphic should include numbered and titled 
thumbnails to represent each movie clip. Save the fi le as a TIFF or JPEG, 
import it into your video editor, and export the fi le as a two-frame 
DV-format movie. Launch MissingMpegTools, click the Mpeg2enc 
tab, and click the SVCD Still radio button. Click the MOV radio button, 
choose your menu movie fi le and output folder in the dialogs, and click 
CLI to encode the fi le. Click the Mplex tab, check the Still box in the 
Mpeg 2 section, click Set Path, and select the menu MPV and output 
folder in the dialogs. Name your menu fi le in the Name Of Output File 
fi eld, and click Mux to create the MPEG.

We created this menu graphic, which displays numbered thumbnails 
of our videos, and then encoded it for SVCD compatibility.

3Encode Video to MPEG-2 Launch MissingMpegTools 
and click the Mpeg2enc tab. In the panel, click the MOV radio 
button, and in the resulting dialog, select your exported DV movie, 
and then click Choose. Another dialog pops up, asking you to select 

an output folder. Select a folder or create a new one to store your encoded 
fi les, and then click Choose. Leave the default settings unless your movie is 
wide-screen format (if so, select the 16:9 radio button) or you live in Europe 
(select the PAL radio button). If you have a dual-processor Mac, check the 
Dual-CPU box to speed things up. Then click CLI; the Terminal launches and 

gobs of gibberish run 
across the window during 
the encoding process. 
This can take a loooong 
time. Be patient. This 
might be a good time 
for lunch. Once you see 
the message “done!” 
followed by the Terminal 
prompt, it’s fi nished.

20 minutes later, the 
Terminal shows that our 
video encoding is only a 
little more than halfway 
done—and this is a 
3-minute clip!

The multiplex section launches a series of dialogs where 
you choose a video and an audio fi le for fusion.
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8Map Out the Navigation Select the fi rst 
movie fi le in the list. At the bottom of the window, use the 
Previous, Next, and Return pop-up menus to assign which 
movie fi le to play when the viewer presses the previous, 

next, and return buttons on a remote control. For example, assign 
the Next pop-up to play the next movie in the sequence. Use the 
Timeout pop-up to assign which movie to play automatically when 
the current one ends. Click Update after setting a movie’s navigation 
but before selecting the next. Repeat for remaining fi les. If your 
movie is divided into chapters, set each Timeout pop-up to play the 
next movie in the sequence. If you have multiple, nonsequential 

movies, set each 
Timeout pop-up 
to go back to the 
menu fi le. When 
you’re fi nished, 
click GenMenu, 
select the output 
folder in the 
resulting dialog, 
and click Save 
to generate the 
XML fi le.

10Get Toasted Now that you’ve got your SVCD 
in virtual format, it’s time to burn it for posterity. 
Launch Toast; in the window, click Other and select 
Multitrack CD-ROM XA from the drop-down menu. 

From your output folder, drag all the image fi les into the Toast 
window in order. Then click Record to burn your disc. When Toast 
chimes to tell you it’s done, 
fi re up your TV and DVD 
player, stick the disc in, 
pop some corn, sink into 
your La-Z-Boy, and enjoy 
the show. Most newer DVD 
players can play SVCDs, 
but some older ones may 
not. If you can’t play your 
creation, don’t rant and 
rave about going through 
this entire process for 
nothing. Just grab your disc 
and go couch-potato it over 
at your friend’s house.

7Order the Items Although MissingMpegTools 
can generate XML fi les—the SVCD building block—
MissingMenuGen offers better navigation. Launch 
MissingMenuGen and click Add. In the resulting 

dialog, select your menu MPEG fi le and click Choose. Click Add 
again, select the movie MPEG fi le that should play fi rst in your 
sequence, and click Choose. Continue adding movie MPEGs in 
the order you want them to appear on your SVCD. When you’re 
fi nished, click the fi rst entry in the window (your menu), and 
select the Set As Menu radio button. Set the Loop fi eld to 0 (zero) 

Times, which makes 
the menu display 
continuously until 
the viewer presses a 
button on the remote. 
Then click Update to 
confi rm these settings.

Add the mixed MPEG 
fi les in the order you 
want them to appear 
by clicking Add, then 
navigating to each fi le.

After dropping our four image fi les 
onto the Toast window (one menu and 
three movies), we’re ready to burn.

9Build the SVCD To make menu and movie fi les 
viewable on an SVCD, you need to turn your work into 
image fi les. Launch MissingMpegTools and click the 
Vcdxbuild tab. Select the Cdrdao Image radio button, 

then click Select. In the resulting dialog, select the XML fi le and 
click Choose. In the subsequent dialog, select the output folder 
and click Choose. Name your collection in the Title Of Tracks 
fi eld and click Build. 
The Terminal once 
again displays the 
process as your 
menu and movies 
get converted into 
image fi les (with 
the extension .img). 
When it’s fi nished, 
open your output 
folder and delete 
any image fi le that 
has “_pregap” or 
“.toc” in its name.

MissingMenuGen allows you to set the SVCD’s 
navigation control for a remote control.

What matters to you more, size or quality? When it comes 
to video, the answer can be subjective once you ponder 
the choices—and get your mind out of the gutter. We had 
you leave video bit rates at MissingMpegTools’s default 
setting of 2,500 Kbps, which compresses DV into good-
quality video. At this rate, you can fi t about 45 minutes of 
MPEG video on a CD. However, you can set higher video 
bit rates, which yield better quality at bigger fi le sizes. Set 
a lower bit rate, and you can cram more movie minutes on 

your disc at the expense of video quality. Depending on 
the bit rate you set, a single CD can store between 35 and 
70 minutes of content. 

If you’ve got a 30-minute or shorter movie collection, 
use a higher bit rate. For a longer movie, consider 
breaking it up across multiple discs rather than setting 
a low bit rate; anything below 1,500 Kbps can make 
your video look worse than VHS tape. The best way to 
determine your quality threshold is to grab a short video 
clip, encode it with different bit-rate settings, and view 
them all.

MissingMpegTools 
takes data from 
your XML fi le and 
creates image 
fi les from your 
MPEGs for SVCD 
compatibility.

QUALITY CONTROL
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1Create the Backdrop Your videos are 720 
by 480 pixels. Your menu should be likewise—unless 
you edit video in iMovie, in which case create a new 
document 720 pixels wide by 540 pixels high. If you 

edit video in a higher-end editor (meaning anything but iMovie), 
create a new 720-by-480-pixel document. Then give your menu 
a background color; click the foreground color swatch in the tool 
palette, choose a color, select the paint bucket tool, and click the 

canvas. Alternatively, 
you can paste in any 
image to serve as a 
menu background, 
as we did.

You’ve spent a good amount of time shooting your video and editing 
it, so what’s one more task? Sure, you can stick all your movies onto 

an SVCD without a menu; the movies will play in sequential order. But if 
you want to give viewers the choice of skipping to the good parts in your 

indie movie, or choosing which movie to view from your 
grab bag of clips, a menu is in order. Here’s how to 
create a still image menu. We used Photoshop, but you 
can apply our instructions to your own image editor.

Create a Static 
SVCD Menu

Wanna help viewers navigate through your SVCD when they 
play it in their DVD player? Create a menu.

by Kris Fong

WHAT YOU NEED
• Any image editor
• Any video editor

To create a solid 
menu background, 
choose any color 
from the Color Picker.

2Add a Title Let your viewers know what they’re 
watching by giving your SVCD a title. Select the text 
tool, choose a font and size from the respective pop-up 
menus in the tool options palette, and then select a text 

color (one that stands out from your background) from the color 
swatch. Click inside the canvas and type a title. Use the move 
tool to place it. If you want to change your font and/or size choice, 
select the text tool, highlight the text on the canvas, and choose 

different options 
from the pop-up 
menus.

If you don’t like the  
font or size you 
started with, just 
highlight your title 
and experiment 
with choices 
afterwards.

3Throw In Thumbnails To create thumbnail 
images, take a screenshot (Shift-Command-3) of 
one of your movies. Open the shot in your image 
editor and crop around the movie image. Repeat 

for other clips. If you’ve got lots of movies, size down each 
thumbnail accordingly so everything will fi t in the menu. To 
add a thumbnail, open the image, copy it, and paste it in the 

menu graphic. To resize 
a thumbnail, choose 
its layer in the Layers 
palette and from the 
Edit menu, select 
Transform, then Scale. 
Hold down the Shift key 
and drag any bounding-
box corner to resize. 
Double-click inside the 
box to set the change.

Depending on the number of 
movie sequences you have, scale 
your thumbnails to fi t them all.

4Add Numbers and Text Use the text tool to add 
a number and title to each movie thumbnail. Remember 
which number you give each movie, as this number will 
dictate the order in which you encode and build your SVCD. 

When you’re fi nished, fl atten all layers, save the fi le as a JPEG or 
TIFF image, import the fi le into your video editor, and create two 
frames (iMovie users should drag the clip to the timeline, press the 

right-arrow key twice, select Split Video Clip At 
Playhead from the Edit menu, and delete the 
second clip in the timeline). Then export the fi le 
as a High Quality DV movie.

Because SVCDs require viewers to 
punch numbers on their remotes to jump 
around sequences, do them a favor and 
supply the reference.

ON THE
DISC

GraphicConverter 4.6 GraphicConverter 4.6 
and Montage 1.1 demo
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Kris Fong is an editor at MacAddict magazine—that means 
she gets to play(giarize) really cool, uh, words.


